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1. Introduction:

Background

1.1.1 The purpose of this Directive is to describe the procedures for the
provision of the BoM Severe Thunderstorm Warning Service in the QLD
Region. The Directive should be read in conjunction with the WOSH and
the QLD Severe Weather Directive. The services detailed in this
Directive form part of the Disaster Mitigation Program that is the Bureau’s
highest priority function.

1.1.3 The RSWS is to annually review and, if necessary, a
RSWS is also to annually check the AIlFS
addresses in conjunction with the MACR.

Definitions

1.2.1 A severe thunderstorm is define
organised group of cells, which
following weather phenomena o

e Tornado (es);:

Wind gusts of

- moist convective cell, or
ciated with one or more of the

thunderstorm definition is meant to include those

quantitative estimates of wind speeds with thunderstorms are not
‘available, and estimated values by untrained observers are in many
cases unreliable. Wind gusts may be assumed to have exceeded 48
knots if any of the following are reporied:

e Trees blown down, snapped off above ground level or uprooted;

e Power lines blown down (not downed by lightning);

e Large quantities of roofing material removed or damage to
structures.

1.2.4 In operational practice, rainfall intensities over periods from 10 minutes to
6 hours should be monitored. Heavy Rainfall Guidelines (Appendix 5)
have been included to give forecasters a first guess at whether observed



values have exceeded the 10 year ARI. A more precise ARl comparison
can be made st o NS

1.2.5 Flash flooding is difficult to define. In general, if an eyewitness reliably
reports flash flooding, the event is recorded as a flash flood. But this can
include anything from water covering a road to a major flood event that
seriously affects life and property and involves major damage. The
Bureau of Meteorology does not forecast flash flooding as it depends on
non-meteorological factors such as topography, soil saturation from past
rain, soil type, vegetation, land use and drainage. However, antecedent
rainfall, together with intensity and duration of thunderstorm rainfall need
to be taken into account when considering conditions tha y lead to
flash flooding. Urban areas are particularly susceptible flooding
and consideration must be given to thunderstorms such
areas that may not reach the above criteria.

SEWS (Standard Emergency Warning Signa

1.3.1 The SEWS is a wailing siren sound used an alertinig signal. It is
played on public media to alert the

urgent safety message relating to am

1.3.2 The SEWS will only be used:

e To alert listeners/viewers
by other means, that
made concerping an:
likely to affec

¢ When the pub
take, specifi

environm

nformed to take, or be prepared to
in order to protect life, property or the

One or more phenomena are classified as destructive.

A thunderstorm event which warrants the use of the SEWS should
produce at least one of the following phenomena:
e Destructive wind gusts > 125km/h (67 knots);
o Very large hail > 4cm in diameter (corresponding to > golf ball
size);
e Tornado (es);
e Intense rainfall which may lead to very dangerous flash flooding (1
to 6 hour rainfall > 50 Year ARI).



1.3.5 With consideration of the above:

The SEWS will only be used given a reliable (and convincing)
report of life threatening conditions due to any of the above
phenomena;

A reliable report would be classified as one originating from an
AWS, official rain gauge, convincing media reports, emergency
services or a storm spotter. Consideration should be given to
proactively contacting spotters in the affected area for visual
confirmation;

Radar data should be considered to refine or support a warning
including the SEWS, but not as an initial trigg
SEWS. Supporting radar evidence could inc

from a warning given a ¢
threatening conditions;

The thunderstorm or syste
of sufficient scale and /

phenomena should be
hat it would be expected to
ole, for example a town or Metro
lerstorm);

erved in the absence of a reliable
gauge reading, thenthe, “This
dangerous” tag should be used in Metro
gs, stronger wording may be included
and/or the wind phenomena upgraded to

d truth reports to trigger SEWS, the awareness of disaster
se agencies can be raised by telephoning the SDCC and
g them using the specific phrase “EMERGENCY WEATHER
LERT".

o Notifying SDCC of an “EMERGENCY WEATHER ALERT"
can be done at the forecaster's discretion when they
believe there are special circumstances requiring
notification of agencies (such as QPS and Local
Government) but that there is insufficient confidence or lack
of ground truth reports to trigger SEWS.

" These values take into consideration operational biases observed with the MESH and Rainfields

values.




1.3.6

1.3.7

o Notifying SDCC of an “‘EMERGENCY WEATHER ALERT"
will trigger SDCC to undertake an appropriate series of
phone calls.

o There is no need to invoke an “EMERGENCY WEATHER
ALERT" if the SEWS or “very dangerous” terminology
is already used in warnings. For example an EWA may be
appropriate when there is radar evidence of large rainfall
accumulations affecting or likely to affect a major
population centre, but that there has been insufficient rain
gauge or spotter reports to confirm if SEWStthresholds
have been reached. *

o Notifying SDCC of an “EMERGENCY.

versa) of the issue of a

The RFC SPOC is authorised i

to discuss the situa

If the SEWS i
Warnings is:
e Transmitt

| sérving the area .[areas affected]... are
“TO USE THE STANDARD EMERGENCY
SIGNAL BEFORE BROADCASTING THIS



2. The Thunderstorm Forecast:

2.1.1 The Thunderstorm Forecast consists of two products, “Day 1" which is
the day of issue, and “Day 2” which is the following day. The preparation
of both graphical products is identical using TIFS. The Thunderstorm
Forecast is a pictorial forecast delineating the area of QLD likely to be
affected by thunderstorms during the rest of the day. It is prepared each
morning using the TIFS software by approximately 11am with “Day 17
applying for the period from the time of issue until midnight, and “Day 2”
applying from midnight Day 1 until midnight on the following day.

2.1.2 The Thunderstorm Forecast should cover all thunderst
non-severe, and should include comments about the p:

= Qrange — areas where thunde
= Red — areas where severe thun

2.1.4 The Thunderstorm Forecast i

2.1.5 The Thunderstorm Ferecast e consistent with RFC policy as set
by the RFC SPOC by ¢ ‘ m. Some differences may arise from
new data being ava C policy has been set (for example
delayed radioso severe thunderstorms are forecast along

state border are rtishould be made to ensure consistency with the

Thunderstorm Forecast is “RFC Policy” regarding the occurrence of
erstorms, formulated after discussion with all forecasters. Once
cided upon, all other forecasts prepared by staff in the QLD region
should be consistent with the Thunderstorm Forecast, unless a change in
policy has been made.

2.1.8 If a significant proportion of Queensland or areas of high population
density are assessed as likely to be affected by severe thunderstorms on
either Day 1 or Day 2, the EMQ SDCC should be contacted on (07) [

as soon as this becomes apparent. This allows EMQ additional
time to organise resources in anticipation of a busy event.




3. The State Severe Thunderstorm Warning:

3.1.1

Content of Warnings

3.2.1

3.2.2

3.2.3

3.24

3.3.2

The State Severe Thunderstorm Warning is issued as an alert to the
public, emergency services and other organisations that severe
thunderstorms are occurring, or likely to occur, in a specified area over
the next few hours. The State Severe Thunderstorm Warning covers all
of Queensland (Map in Appendix 1a, example in Appendix 2b). The
validity time of the warning is three hours, though the warning can be
updated when required.

The wording of State Severe Thunderstorm Warning:
generated by the TIFS software, but in some cas
the forecaster.

State Severe Thunderstorm Warnings will descri
weather phenomena (i.e. large hail, damagi
tornadoes or heavy rainfall that may lea
accompany thunderstorms. Indication
of severe thunderstorms can be giv.
Warning.

he most likely
or destructive winds,
ash flooding) that will
idence level and impact
areful wording of the

State Severe Thunderstorm
observed or forecast to b
next three hours.

warned area, as w
will also contain re

re weather (for example from Storm Spoiters,
eliable media reports or other sources) may be
ight to the severity of the warning. A section within
s to be done quickly. The forecaster still needs to fill in
as location, time and phenomena reported.

he State Severe Thunderstorm Warning is produced using the TIFS
system. Procedures for generating the State Severe Thunderstorm
Warning using TIFS are contained in Appendix 8a. If TIFS in not
functional then warnings should be prepared using the YABBY system,
available at hitp://

The State Severe Thunderstorm warning should first be issued when
deep convection develops in an area deemed favourable for severe
thunderstorms (the red area on the Thunderstorm Forecast). A State
Severe Thunderstorm Warning should also be issued when there is
evidence that severe thunderstorms are occurring or are soon expected
to move into Queensland.




3.33

3.3.4

3.3.5

3.3.6

3.3.7

3.3.9

Only one warning will be issued that will include all areas within
Queensland forecast to be affected by severe thunderstorms. An
exception to this is the Metro Severe Thunderstorm Warning, which can
be issued for parts of southeast Queensland. If warning for separate
phenomena in two different areas, separate sections can be assigned to
each region, this will then be reflected in the text. The heading of the
warning will include all the phenomena warned for in all the sections.

The area covered by a State Severe Thunderstorm Warning should be
kept as small as possible bearing in mind the uncertainty sometimes

Destructive winds (gusts >125km/h) should
thunderstorm warnings when forecast or observ
supercell thunderstorms in many cases will

mentions “damaging winds” or only phenomena other than
winds, they should re-issue the wa e “destructive winds”
button on TIFS selected, which wi e the appropriate text. If
“destructive winds” have been,
should consider whether usin
on section 1.3 of this Directi:

Warnings will not mention specific

o this would be exceptionally severe
g-lived supercells and/or thunderstorms with
“destructive winds or intense rainfall expected

thunderstorms. Ch
thunderstorms s
likely hail >4cm

ction statements have been agreed with EMQ and are
“the warning form. TIFS automatically selects the relevant

vere thunderstorm. A list of these action statements is included in the
xample warning in Appendix 2b.

If NWP data and/or upper air observations indicate a strongly favourable
environment for severe thunderstorms then, at the discretion of the RFC
SPOC, the district forecasts may be updated to include the possibility of
damaging winds, large hail etc.

The Zoomed State Severe Thunderstorm Warning may be used when
thunderstorms are only occurring in either the broader southeast
Queensland region, or in northern Queensland. Maps of these areas are
provided in Appendix 1b.



Updating a State Severe Thunderstorm Warning

3.4.1 State Severe Thunderstorm Warnings should be updated if not
representative of the current situation, and routinely at least every
three hours. The validity time of State Severe Thunderstorm Warnings
should not exceed three hours. Where possible excessive updates
(under 3 hours) should be avoided.

Cancelling a State Severe Thunderstorm Warning

3.5.1 State Severe Thunderstorm Warnings should be cancelled when severe

development is anticipated. This will help ensure that
that the risk of severe weather has passed. The

will continue to be monitored and further warning
necessary.” TIFS is designed to do this automatically.

3.5.2 EMQ action statements should rem
if severe weather has been expe
programmed into TIFS. For exampl
and powerlines may be on the .gr
appropriate emergency servi
should be removed only if a v

not eventuate.

ber for assistance. They
g is cancelled for conditions that did



4. The Metro Severe Thunderstorm Warning:

411 The Metro Severe Thunderstorm Warning is an enhancement to the
base level Severe Thunderstorm Warning service for the populated
southeast corner of the state (map in Appendix 1a (dashed outline) and
Appendix 1¢). The validity time of the warning is up to one hour, with a
desired routine update time of thirty minutes.

Content of Warnings

4.2.1 The wording of a Metro Severe Thunderstorm Warning is automatically

the forecaster.

4,22 Metro Severe Thunderstorm Warnings will desc likely
weather phenomena (i.e. large hail, damaging or winds,
tornadoes, or very heavy rainfall that may lead “flooding) to affect
an area.

4.2.3 Metro Severe Thunderstorm Warnings, ar ompanied by a graphic
depicting existing severe thunderstorms: eir direction of movement

during the next 60 minutes. In some , forecasters may reduce
this time to 30 minutes if not co ngevity or movement. The
warning graphic will also ence to a State Severe
Thunderstorm Warning (if cu
ascertained. :

4.2.4 The graphic will inclu
area in yellow,
from severe thu

4.2.5

aphical warning product using TIFS. This will also append enhanced
ng in the text of the warning. The forecaster should consider
hether using the SEWS will be necessary as described in Section 1.3 of
his Directive.

4.2.6 Reliable reports of severe weather (for example from Storm Spotters,
Bureau Observers, and reliable media reports or other sources) may be
included to add weight to the severity of the warning. A section within
TIFS allows this to be done quickly. The forecaster still needs to fill in
specifics such as location, time and phenomena reported.



Area covered by the Metro Severe Thunderstorm Warning

431 The Metro Severe Thunderstorm Warning covers the following Local
Government Areas (a map is provided in Appendix 1¢):

Brisbane City
Cherbourg Shire
Dalby (partial)

Gold Coast City
Gympie

Ipswich City

Lockyer Valley
Logan City

Moreton Bay
Redland City

Scenic Rim
Somerset

South Burnett
Southern Downs (partial)
Sunshine Coast
Toowoomba (partial)

rm Warning

ning is produced using the TIFS
enerating the Metro Severe Thunderstorm
ontained in Appendix 8b. If TIFS in not
functional then d be prepared using the YABBY system

available at
4.42 The Me derstorm warning should be issued when there is
i vere thunderstorms are occurring or expected to move
t Queensland metro warning area within the next hour.
4.4 atically generated text can be edited if desired in order to
~convey the warning message.

ocation of individual thunderstorms is best described in terms of
ajor towns and suburbs or recognised geographical localities.
Distances should be in kilometres not nautical miles.

4.4.5 A number of action statements have been agreed with EMQ and are
included on the warning form. TIFS automatically selects the relevant
action statements for each type of severe weather associated with a
severe thunderstorm.

4.4.6 If NWP data and/or upper air observations indicate a strongly favourable
environment for severe thunderstorms, then at the discretion of the RFC
SPOC the district forecasts may be updated to include the possibility of
damaging winds, large hail etc.



4.47 An example of a Queensland Metro Severe Thunderstorm Warning is
shown in Appendix 2c.

Updating a Metro Severe Thunderstorm Warning

451 Metro Severe Thunderstorm Warnings should be updated if not
representative of the current situation, and routinely at least hourly,
with an ideal update period of thirty minutes. The validity time of Metro
Severe Thunderstorm Warnings should not exceed one hour.

Cancelling a Metro Severe Thunderstorm Warni g

4.6.2

derstorms are no
st of Dalby from
threat of severe
| continue to be monitored
ssary”. TIFS is designed to

should be reflected by text similar to:
longer affecting the Southeast Quee
Rainbow Beach to Stanthorpe). Th
thunderstorms has passed, but '
and further warnings will be is
include this text automaticall




5. Relationship Between Products:

Between Metro and State Thunderstorm Warnings

5.1.1

51.2

51.3

514

515

5.1.7

The base-level thunderstorm warning service for all of Queensland is via
the State Severe Thunderstorm Warning.

A more detailed Metro Severe Thunderstorm Warning is an
enhancement of the State Severe Thunderstorm Warning for southeast
Queensland. The Metro Warning should be viewed as providing
additional detail in high population areas to assist in the efféctiveness of
the warning service in these areas. '

be, achieved
discussed in

conSIstent with the State Warmng This can
thOUgh adequate cross-referencing between

There will be occasions when Se rstorm Warnings are
situations, the forecaster
however a State Warning
warning lead-time. If a State
sued for surrounding parts of the
istent with the Metro Warning and

can also be issued to provid
Warning is current, or,_subset
state, these warnings.must be
vice-versa. If a Stat
severe thunderstory
must remai vhile:Metro Warnings are current.

If both for g are required to be issued for the Metro Warning

rming should be 1ssued first for the larger area,

ase level service and the Metro Warning becomes simply an
service added to the State Warning.

sverall threat to continue, the State Wammg can be referred to in the
cancellation message.

If both Metro and State Warnings need to be cancelled at the same time,
the State Warning should be cancelled first followed by the Metro
Warning. This ensures that no warning areas are present in the
cancellation messages or graphics. In this situation the SWM shouldn’t
cross reference the Metro Warning in the State cancellation text as it will
soon be cancelled.



Cross-referencing of Warnings

5.2.1 If State and Metro Severe Thunderstorm Warnings are both current they
should make mention of the other product. This is easily done by clicking

the & icon in the text window of the TIFS State Warning screen. This
will include the text, “At (time, date) a separate, more detailed Severe
Thunderstorm Warning was current for the Southeast Queensland area
(east of Dalby from Rainbow Beach to Stanthorpe). Refer to this product
for more information”. Conversely if a Metro Warning is issued while a
State Warning is current, TIFS will automatically add, “A more general
severe thunderstorm warning is also current for (selected) districts”.

Between Severe Thunderstorm and Severe Weathe
Warnings

531 The Severe Thunderstorm Warning Service
complementary to the Severe Weather Warning

5.3.2 At the forecaster's discretion, a S
issued concurrently to a Severe W
value can be added than through
Warning alone.

5.3.3 f severe thunderstorms
Weather Warning i

3 Severe Thunderstorm Warning would be issued

nediately, cross referencing the broader threat specified in the

evere Weather Warning. The Metro Severe Thunderstorm

Narning would be updated at half hourly to hourly intervals until

he threat has passed,

An update to the Severe Weather Warning would be issued as

soon as possible to cross reference the Metro Severe

Thunderstorm Warning. The Severe Weather Warning would be

updated at least at 3 hourly intervals while the Metro Severe

Thunderstorm Warning was current;

e When the threat of Severe Thunderstorms has passed, the Metro
Severe Thunderstorm Warning will be cancelled but will cross-
reference the broader threat that remains in the Severe Weather
Warning. The Severe Weather Warning will be updated to reflect
this and also cross-reference the cancelled Metro Severe
Thunderstorm Warning.



5.3.4 If Severe Thunderstorms affect the regional Queensland area, and a
Severe Weather Warning is current for the same districts, then:

e The Severe Weather Warning would be updated immediately,
ensuring that Severe Thunderstorms and the associated
risk/impact is detailed thoroughly. The Severe Weather Warning
would be updated at least at 3 hourly intervals while Severe
Thunderstorms were affecting the same area.

e |If large hail is expected, ensure this information is clearly and
predominantly detailed in the text within the Severe Weather
Warning. A separate state Severe Thunderstorm Warning
won't be issued.

e When the threat of Severe Thunderstorms has
Severe Weather Warning will be updated to refle

535 If a State Based Severe Thunderstorm Wa
thunderstorms spread into areas of heavy rain wit

additional value would be added by changin
negate the possibility of Severe Thunderstorni’

‘ hunderstorm Warnings, both
n Warnings are not required to be
referenced in the “W ry at issue time” section of the State

or District forecasts.




6. Monitoring:

Sources of Information

6.1.1 Sources of information can be divided into two groups: the standard
information received by the RFC and information received from special
observers or the public.

6.1.2 Standard information received by the RFC includes:
e Synoptic, upper wind and temperature data;
e AWS and rain gauge data;
e Radar and satellite imagery;
e Analytic fields derived from the above infor
e Prognostic fields from computer models.

6.1.3 Damage reports can also be received through t
online forums. While they are a valuable source
is advised when considering reports from thes

> media, or even through
f information, discretion
nal sources.

Storm Spotters

6.2.1 The Storm Spotter network
community who have unds
occurrences to the
telephoning a dedi

and mailing ‘Severe

d of volunteers from the
report severe thunderstorm
potters are asked to report either by

ber (1800 [ENEEEE), by filling in
Reporting Cards’, through an online
www.bom.gov.au/storm spotters, or email to

6.2.2 call number will ring at the “radar” desk in the
severe ction. This has been diverted to the severe weather
desk (e

6.2.3

g telephone reports from Storm Spotters, the following
hould be noted:

The severe weather phenomena and/or damage observed
The location at which the storm occurred
The time at which the storm occurred

6.2.4 All Storm Spotter reports and any other reports indicating severe
thunderstorm activity are to be passed to the RFC SPOC and RSWS.
They should also be entered into the “Severe Weather Loghook” located
at http:// Spotter reports received via the online reporting form will
automatically appear in AIFS Alerts and via email to
@bom.gov.au.



Responsibility for Monitoring

6.3.1 The overall responsibility for the Severe Thunderstorm Warning Service
resides with the RFC SPOC. During the period when severe
thunderstorms are climatologically common, the day-to-day provision of
the Severe Thunderstorm Warning Service is delegated to the
forecaster(s) at the Severe Weather Desk when it is in operation.

6.3.2 There is no formally defined “severe thunderstorm season” for
Queensland, however a dedicated Severe Weather Desk inidhe RFC will
be staffed from 4:45 am to 9:00 pm local time 7 days \
from the beginning of October to the end of Marg
extended depending on prevailing conditions. While
Desk in the RFC is staffed, the duties of the .gf

include:
e assessment of the likelihood of severe thunder
e monitoring of radars and other srelevan
observations;
e preparation of Severe Thunder
e answering of telephone calls .on the re Weather Desk or

media enquiries related to Sev

6.3.3 If heavy rainfall that may lea ng is considered likely then
the Hydrology section sho during normal working hours.
vorki staff are to be contacted as

6.3.4 During the peri
staff will aid i

iade the previous afternoon and, if necessary, revised
question.

Id be familiar with all severe thunderstorm forecasting
s including SONDTOOL, Helindex, Convective Analyser,
FS, NTFGS, satellite data, NWP data and use of 3D RAPIC. Useful
rences for severe weather forecasting/diagnosis techniques can be
nd in Appendices 4 to 8.

6.3.5

6.3.6 Where possible Severe Thunderstorm Warnings should only be prepared

by staff who have completed the Bureau Severe Thunderstorm
Competencies checklist.



7. General Information for Severe
Thunderstorm Warnings:

Task Priorities

7.1.1 The RFC SPOC should ensure that the Severe Thunderstorm Warning
Service is maintained during those periods when the Severe Weather
Desk is unattended. Routine work may be delayed or, under extreme
conditions, cancelled to allow the service to continhue. At the
discretion of the RFC SPOC, the severe weather shifts ma extended

affect the heavily populated areas of southeast Q
the Metropolitan Warning Area.

7.1.2 Meteorologists preparing Severe Thunderst
priorities to tasks. The following tas
possible:

1. Preparation of Severe Thun
monitoring of data to be i
or phone calls from EM

. Issuing routine forec

Handling tele
over those fro

UDES A TORNADO WARNING”

ext will be automatically generated when the i button in TIFS is

fselected

7.2.2 A tornado warning will require activation of the SEWS. As such a reliable
report of a tornado should be received before including this
phenomenon. See section 1.3 for information about use of the SEWS.



Dissemination of Severe Thunderstorm Warnings

7.3.1 The warning is transmitted to media outlets in the appropriate weather
districts, Weather by Fax, phone warning, the Bureau’s Internet and
other fire and emergency organisations that have made arrangements for
transmission. Severe Thunderstorm Warnings may also be distributed to
non-emergency service or non-media clients but will be charged for at a
cost-recovery rate.

7.3.2 The officer issuing a Severe Thunderstorm Warning must check that it
has reached the Bureau's external website at www.bom.gov

7.3.3 The Warning will be automatically recorded using

not functional then the warning should be prépared
system, available at h‘ctg:/[g[.

Internal Liaison

7.4.1 Upon issuing a Warning the res
forecasters in the RFC and an
thunderstorms. RSWS staff.
area to obtain dama
obtain reports of an
upload them directl
Severe Weather )

should inform all

y to be affected by severe
tact WSO'’s in the nominated
sely, WSO'’s are requested to
torms and send these to RSWS or
inks, photos and images, to the

7.4.2 consistency across the QLD/NSW, QLD/SA and

oughout the severe thunderstorm season. It is difficult to
al consultation process, however consultation should be as
acticable in the morning and continue at regular intervals
e day as the severe thunderstorm situation and warnings

nge. When severe thunderstorms are likely or are occurring near the
LD/NSW, QLD/SA or QLD/NT borders, it is important that the issue of
warnings be co-ordinated between the regions. Contact details are as
follows:

NSW Severe Weather: (02)
SA Severe Weather: (08)
NT RFC SPOC: (08)

External Liaison

7.5.1 The officer issuing the Warning is responsible for ensuring that the EMQ
SDCC Watch Desk Officer is advised by telephone at the time of issue of



both the FIRST and FINAL Severe Thunderstorm Warnings, and of any
significant changes in policy. The number is (07) ﬁ(all hours).
The EMQ SDCC Watch Desk Officer can also be contacted to pass on or
request significant reports of severe weather.

Call-out of Engineering Staff

7.6.1

7.6.2

7.6.3

7.6.4

After noticing or being notified of an unplanned radar outage the RFC
SPOC should check for any previously logged fault reports at
hitp:// | RER NoNe are present a fault report should be entered.

action. If a radar goes offline, and if thunde
expected before the next working day for the regi
made to return the radar to service as soon as po

Contact numbers can also be found"
is any impending or expected preci
RESM should be phoned immediate
weather is expected, at the discretio
be sent a Short Messag

http://www.... . a
doubt it is preferred to pk
contacted, a period of " e allowed, then the relevant TO 4
contacted as per the i

ified of the outage. If fine
FC SPOC, the RESM can

TO 4 - Cairns:

TO 4 - Townsville

- R (0408 RN

The RFC SPOC should also send an alert to inform the NMOC Helpdesk
and technicians of the outage. This way any relevant Radar Service
Interruption Notice (RSIN) can be updated. This can be done through a

GUI at http://. . also
found under the Fault Report page. If the GUI doesn’t work, an email
should be sent to QLD @bom.gov.au including any known

information from the list below:



Name of radar facility;

Service that will be affected;

Extent of outage;

Reason for outage;

Estimated or actual Outage start time;

Estimated Return To Service time;

Point & method of contact for further information;

Point & method of contact for BOM Staff dealing with the Outage.

Contingency Procedures during Severe Thund
Events

7.7.1 Full contingency procedures are outlined in th
Warning Continuity Procedures at:
http:/Avww.qld.bom]
and the Queensland Regional Conti

hitp://web.bom. |

Radiosonde and Weather Watc

7.8.1 If severe thunderst

erstorms are occurring at the time of a
the RFC SPOC can authorise delaying or

7.8.2 Conversely, 4
scheduled

“major thunderstorm events generating considerable media
‘est, any available non-operational staff should be utilised in
nswermg telephone calls and assisting with media interviews, though
only after being given suitable briefing. The RFC SPOC is encouraged to
call in additional staff to assist with the extra workload if needed.



8. Follow-Up Procedures

Archiving Information

8.1.1

812

8.1.3

Verification Statistics

8.2.1

RSWS is to maintain the Severe Weather and Thunderstorm Logbook,
located under the “Disaster Mitigation” internal homepage at
htto/iwww.ald.bom.gov. [l This includes
notes on any Warnings issued; telephone advice given to emergency
services, the media or other interested parties (such as organisers of
major outdoor functions); any weather observations or reports of severe

reports, otherwise the generic Wiki login can be
handed to RSWS staff for entry.

| retained lies with the Severe
vent.

RSWS is respo
and as such js
Thunderstor
Severe

assessing all Severe Thunderstorm Warnings,
5 annual verification statistics for the Severe
ervice. The following are to be assessed for all
arnings:

severe thunderstorm phenomena;

described in Chapter 8 of the WOSH, the aim of the Severe
understorm Warning Service is to provide:

e A Probability of Detection (POD) of 70% or greater;

e A False Alarm Ratio (FAR) or 40% or less; and

e At least thirty minutes lead time (ie. time between the issue of the
Warning and the occurrence of the severe phenomena) on 70% of
occasions.

8.2.3 When assessing Severe Thunderstorm Warnings, the following

definitions are used:
_ No of Correctly Forecast Events
e POD= y ITotal No. of Events

— No. of False-Alarm Warnings
e FAR= ¢ ITotal No. of Warnings



8.2.4 Many occurrences of severe thunderstorms are not reported in the media
or to the Bureau of Meteorology. Insurance data on the occurrence of
severe thunderstorms is also questionable as many people are not
insured or may not claim. Hence it cannot be definitely stated that
severe thunderstorms did not occur over an area where they are
suspected to have occurred. This is especially true given the vast size of
the Queensland warning area, and the great distances between
population centres. It is acknowledged that POD and FAR statistics are
therefore not a perfect representation of the accuracy of the warning
service.

Reports

8.3.1 RSWS is to prepare case studies of severe thunders
significant human and/or economic impact.

Major Events in QLD

8.4.1 A Severe Weather Summary is by the SMSW or RSWS
staff after significant severe we .
brief the Bureau Executi urn provides briefing to the
Departmental Secréf . Guidelines for issuing Severe
Weather Summaries n Annex 4 of the WOSH.

8.4.2 The RFC SPOC
life associated wi

ould monitor reports of damage and loss of
weather events. The RD or other senior

e disruption to services (affecting tens of thousands of
fe in a major city or more than half the population in a
rovincial city);

Widespread media coverage and/or criticism of Bureau services;
Direct interest of the Minister or another senior Minister's (this
includes events affecting the Minister's own electorate).

8.4.3 On weekends and public holidays the RD can be contacted at home on
the number given in Appendix 3. The RD will liaise with Head Office staff
about whether a ministerial briefing is required and will implement an
appropriate media strategy. The Severe Weather Summary should be
prepared regardless of whether a ministerial briefing is required.

8.4.4 A Severe Weather Summary should be available in Head Office by
10:30am (Melbourne time) on the day after the event. In some
circumstances the RD may request that available information be



forwarded to Head Office as soon as possible, followed by the complete
Severe Weather Summary within normal time limits.

8.4.5 The Severe Weather Summary should contain the following information:

an event summary describing what happened, where and when,
the impact on life and property, and the disruption caused to
services;

time of onset and duration of severe weather (particularly
important);

warning/forecast summary: a concise summary of relevant
warnings and forecasts including time of issue. .This should
include a candid assessment of the adequacy of forecasts and
warning and their lead-time;

media/user comments. Include extent, seve
criticism;
facilities. Include any equipment failures o
may have affected warning performa

may have been taken.

8.4.6 The above information may also b to a Severe Weather
Talking Points by the SWM or RE the benefit of other RFC

staff or for the preparation of th




Appendix 1a:
Qld State Severe Thunderstorm Warning
Area

Bureau of Metesralogy issued at 08 Dec 11:45 am EST
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Appendix 1b:
Qld State Severe Thunderstorm Warning
Areas — Zoomed

issusd at OF Dec 11:47 am EST

Bureau of Meteorclogy
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Appendix 1c:
Qld Metro Severe Thunderstorm Warning
Area

iszued at 11 Sep o

386 pm EST
valid af 11 Sep 355

Eureau of Meteorology
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Thunderstorm Location, 60 min Forecast
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Appendix 2a:
Example of Thunderstorm Forecast:

IDQB65758

Bureau of Meteorology

Queensland Regional Office

THUNDERSTORM FORECAST

Issued at 4:43 pm Thursday, 11 September 2008,
Valid until midnight on Thursday, 11 September 2008.
A trough moving through southeast Queensland is likely to trig
thunderstorms over the broader southeast of the state. Thund

hail, damaging winds and heavy rain. Isolated thundersto
reach the Southeast Coast District later this evening.

Bureau of Meteorology sued at 02 Sep 303 pm EST

THUNDERSTORM FORECAST Day 1

o
M Tropical Coast & Tablelands

Part Douglas

JCains
7
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&
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Appendix 2b:
Example of State Severe Thunderstorm
Warning:

TOP PRIORITY FOR IMMEDIATE BROADCAST

SEVERE THUNDERSTORM WARNING

for DAMAGING WIND and LARGE HAILSTONES

For people in the Central Highlands and Coalfields, Ca
and Burnett, Darling Downs and Granite Belt, Southe
of the Central Coast and Whitsundays, Central West
Warrego Forecast Districts.

Issued at 10:12 am Thursday, 8 December 2011.

Severe thunderstorms are likely to produce
hailstones in the warning area over the next sev:
may be affected include Warwick, Gold
Maroochydore, Roma, Gympie, Bundab

+and large

. Locations which
1ba, Brisbane, Dalby,
ne, Emerald,
Goondiwindi.

* Avoid using the telep g a thunderstorm.
* Beware of fallen werlines.
* For emerge sontact the SES on 132 500.

to be issued by 1:15 pm.

orms develop in the Southeast Queensland area (east of
w Beach to Stanthorpe), a more detailed Severe
Warning will be issued to people in this area.

gs are also available through TV and Radio broadcasts, the Bureau's
ite at www.bom.gov.au or call 1300 659 219. The Bureau and Emergency
Management Queensland would appreciate warnings being broadcast regularly.
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Appendix 2c:
Example of QLD Metro Severe
Thunderstorm Warning:

TOP PRIORITY FOR IMMEDIATE BROADCAST

SEVERE THUNDERSTORM WARNING - SOUTHEAST

QUEENSLAND
for DAMAGING WIND and LARGE HAILSTON

For people in the GOLD COAST CITY and parts of the L
LOGAN CITY, GYMPIE, IPSWICH CITY, SCENIC RIM,
BURNETT, TOOWOOMBA, REDLAND CITY, CHERBO
North Stradbroke Island Council Areas.

Issued at 10:15 am Thursday, 8 December 2011.

The Bureau of Meteorology warns that, at 10:
thunderstorms were detected on weather r
north of Gatton. These thunderstorms arg
Very dangerous thunderstorms are fore
and the area west of Esk by 10:35 am'and:Es
11:05 am.

gerous

pton and the area
ards the east to northeast.
affect the area southwest of Esk
nd the area south of Esk by

ocat ear the area northeast of Kingaroy,

Other severe thunderstorm
; orecast to affect the ranges between Gympie

g the telephone during a thunderstorm.
fallen trees and powerlines.
emergency assistance contact the SES on 132 500.

The next warning is due to be issued by 11:15 am.

A more general severe thunderstorm warning is also current for the Central
Highlands and Coalfields, Capricornia, Wide Bay and Burnett, Darling Downs
and Granite Belt, Southeast Coast and parts of the Central Coast and
Whitsundays, Central West and Maranoa and Warrego districts.

Warnings are also available through TV and Radio broadcasts, the Bureau's
website at www.bom.gov.au or call 1300 659 219. The Bureau and Emergency
Management Queensland would appreciate warnings being broadcast regularly.
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Appendix 3:
Contact Details

NG (0 7

3230 8739
3239 8741

Jim Davndson
Bruce Gunn

SWM (PO 2)
SWM (PO 2)
Storm Spotters

'RFC SPOC
Sev Wx Desk
RFC Fax

Hydrology
Manager

Supervising
Hydrologist

‘Regional Services
Manager (RESM)
TO 4

1900 969 922
(More contacts at hitp:/.......ccccevvriiinccrccrriiecs )

QLD Warnings




Appendix 4:
Radar Signatures Indicating Storm Severity

Reflectivit










SH - Cyclonic Rotatien




0L - 0%

s

-iF

fed

s

X 10

3]

-1

-0g

1X

Append

$7|..21818p0
S15BIAID .mm :

nawmg 7 e apPLA
[y MBI 3 SUM0(T SUIlE(

0TaLE ), 5 BOUBIETY
Arpumo; [auwey;|

1534 TBIUa))
Sp[aL[eo;) 3 SPURSTH [BUUA])
enLpoLdey

(e
[a}

ey

L]

sepumsingay 4 15807 [BOATE))
UD[epay 18M0T PUR YIS

e
(31

[

I

Heavy Rainfall Guidelines and Maps

1se0) [Bardoa] YLoh]
saopurp Jadd[) 2 SPIOUPIOL) WIBMION
Lmmoy 0o

=

3 o

Wy

P

(3]

(http:/...

n

o




30 Minute Rainfall Thresholds
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1 Hour Rainfall Thresholds




2 Hour Rainfall Thresholds
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3 Hour Rainfall Thresholds
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6 Hour Rainfall Thresholds
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Appendix 6
Mesocyclone Nomogram
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Appendix 7:
Large Hail Nomograms
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Appendix 8a:
Guide for issuing State Severe
Thunderstorm Warnings using TIFS

This guide can be found online at

n  Off intowarning mode.

Step 2: Draw a warning area

GPATS data can be viewed by selecting the
overlay in the top left of screen but please
remember to press "refresh” to get the latest
data.

7 Features

A second warning area can be added by
changing the number in the Warning Section
tab of the Area Editor. For example a warning
with heavy rain in northern Queensland and a
warning for large hail, heavy rain and
damaging winds in southeast Queensland at
the same time.

Step 3: Add severe phenomena

These "phenomena" are damaging winds (290kmh),
destructive winds (2125kimh), large hail (22cm), heavy
rainf (10 year ARI) and/or tornadoes.




Step 4: Cross-Reference any Metro Warnings

—In the text editor click the "Skyscraper"” button to include a statement
E referring to a Metro Warning being current. Do this if a Metro Warning is
" current or just about to be issued.

Step 5: Choose text detail level and edit text

Bring up the text part of the warning using
View -> Text Warning.

The detail level of the automati
text can be set with the d
engaged in this step, the
should not be touched:z
the text and wipe out ar
text.

Step 6: Issue

lected address zones.
erstate RFC’'s with a
products have reached the

Click the "lssue" button and double che
Ring the EMQ SDCC on (07)
border affected by the warning and
external website. )

ep monitoring the situation.

State-Based Warning in TIFS

Tick the Cancellation box under the Options menu.
Make sure all graphics are deleted from the display. This is
quickly achieved using Tools --> Clear Areas.



Appendix 8b:
Guide for issuing Metro Severe
Thunderstorm Warnings using TIFS

This guide can be found online at
hitp/l s e e R i s

Step 1: Turn "Auto Refresh” off

- Turning "Auto Refresh" off switches from monitorin
On Off intowarning mode.

Step 2: Get rid of unwanted cells
These cells are storms that you do not intend to warn for.
of deleting cells:

Visible % %Any ¥IL

Step 3: Reshape and

ot

positions and cell motion vectors

Manual motion assessments can
deviate substantially from the
automated motion assessment
by TITAN/WDSS. Drag the cell
and the tip of the cell motion
vector to an adjusted position
while holding the left mouse
button in General Mode.

Step 5: Draw the immediate threat area

Add the immediate threat area using the Add Area
button.

Any point location in the immediate threat area should
be likely to experience severe convective weather over
the next 60 min (for a 60 minute warning duration). Note
that locations "behind" the cell should not be in the
immediate threat area, and that the threat area should




fan out away from the cell due to increasing uncertainty
in the cell location with increasing forecast lead time.

Step 6: Add severe phenomena or "Very Dangerous™ tag

These "phenomena" are damaging winds (290kmh),
destructive winds (2125kmh), hail (22cm), heavy rain
(10 year ARI) and/or tornadoes.

Adda" Yery Dangerous" tag
7. VERY DANGEROUS STORM from the cell editor if very large hail (>4cm), destructive
winds (>125kph) or very heavy rainfall (>50.year ARI).

Step 7: Choose text detail level and edit te

Bring up the text part
View -> Text Warning.
The detail level of the automatically generated
text can be s

Step 8: Issue

Click the "Issue" butt eck the pre-selected address zones.
Ring the EMQ SDCC 'on (07) EillEEER, "ing the NSW RFC if the warning
reaches the borderand ¢l hat products have reached the external

resh” on to keep monitoring the situation.

lation of a Cell-Based Warning in TIFS

Tick the Cancellation box under the Options menu.

Make sure all graphics (cells and areas) are deleted from the
display. This is quickly achieved using Tools --> Clear Areas
and VIL filtering (see Step2 above).




Doc 2

From: !

Sent: Sunday, 22 January 2012 15:52

To: QLD Severe Weather; QLD RFC SPOCs

Ce: @] ; QLD Forecasters;

Subject: Update to the TS Directive [SEC=UNCLASSIFIED]

Security Classification: UNCLASSIFIED
Hi All,

A couple of updates to the Thunderstorm Directive as listed below. The new
version is on the web.

The first change is with respect to the "Emergency Weather
when a SEWS-like event is suspected of occurring but with
report.

If there is insufficient confidence or lack of ground truth reports to tri
awareness of disaster response agencies can be raised by teleph
alerting them using the specific phrase “EMERGENCY WEAT

- Notifying SDCC of an “EMERGENCY WEATHER
discretion when they believe there are special circumsta
(such as QPS and Local Government) but that there is
ground truth reports to trigger SEWS.

- Notifying SDCC of an "EMERGENCY WEAT!
an appropriate series of phone calls.

appropriate when there is radar evi
affect a major population centre, bu
reports fo confirm if SEWS threshol

- The RFC should immi
rainfall” EWA to the

e are present a fault report should be entered.
With sideration to prevailing weather conditions, the RESM should be contacted after the
failure of any radars in QLD. The RFC SPOC will determine the need for data and
request the timeframe for necessary action. If a radar goes offline, and if
thunderstorms are current or expected before the next working day for the region, all
efforts should be made to return the radar to service as soon as possible.

Contact numbers can also be found in Appendix 3. Out of hours, if there is any impending or
expected precipitation near the affected radar, the RESM should be phoned
immediately to be notified of the outage. If fine weather is expected, at the discretion




of the RFC SPOC, the RESM can be sent a Short Message Service (SMS) from the
GU! at hitp: _q also found under the

fault report page. If in doubt it is preferred to phone the RESM. If the RESM cannot
be contacted, a period of 4 hours should he allowed, then the relevant TO 4
contacted as per the following list:

RESM:

- B R

TO 4 - Southeast QLD and Rockhampton:

TO 4 - Cairns:

TO 4 - Townsville

. ] (04 RIS

VMOC Helpdesk and technicians of
Jption Notice (RSIN) can be updated.

htto [l also found under the Fault
sentto QLD [ @bom.gov.au ii

e GUI doesn’'t work, an email should be
any known information from the list below:

Cheers,

| Meteorologist
Queensland Regional Office
Bureau of Meteorology, Brishane

www.bom.goviau.



